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INTRODUCTION
Visualizing the fine morphological details of cells can only be 
achieved with EM. With its nanometer resolution, EM gives 
greater structural context by revealing all the membranes and 
large stained macromolecules. When combining EM with in vivo 
light microscopy, the structural dynamics captured across various 
timescales1 can be correlated with the underlying ultrastructural 
morphology. The synaptic connections between axons and den-
drites, for example, can only be seen with EM. The growth of den-
dritic spines in the adult mammalian brain, seen with two-photon 
in vivo microscopy, has been verified as new synaptic connections 
by using post hoc serial section transmission EM2,3.

Locating the same structure in images obtained using the two 
imaging methods has typically relied on transforming the label 
seen with light microscopy into an electron-dense stain that can be 
identified in the electron microscope2,4. In the case of correlative  
in vivo light microscopy and EM of neurons5, the GFP present in 
the cytosol is stained using immunocytochemistry to produce the  
electron-dense precipitate of 3, 3-diaminobenzidine tetrahydro-
chloride. After resin-embedding, the sample is then serially thin-
sectioned, and imaged with transmission EM. This technique is 
labor-intensive, requiring high levels of skill to manually collect hun-
dreds of sections followed by many hours of microscopy to locate 
and image the region of interest. These images are then aligned, again 
manually, and the analysis of the ultrastructure can then begin. As 
well as being time-consuming, this targeted ultrastructural analysis 
relies on having sufficient labeling in the thin sections to recognize 
the previously imaged structures. This is achieved by using weaker 
fixatives, and tissue permeabilization is used to improve the anti-
body penetration and strengthen the labeling. However, this results 
in suboptimal ultrastructural preservation.

FIBSEM produces large series of aligned images through tis-
sue samples with limited human intervention6,7. In addition, the 
sequential imaging and milling with the electron and ion beam 
results in isotropic image stacks from which structures such as 
axons, dendrites and synapses can be segmented automatically by 
using computer software.

This protocol describes how FIBSEM can be used to image vol-
umes of brain tissue containing axons and dendrites previously 
studied in vivo in the adult mouse brain. With the microscope’s 
ability to accurately target specific regions, no labeling of the 
fluorescent neurites is used. Instead, the neurites of interest are 
identified after the tissue has been chemically fixed and fiducial 
marks have been burned around this region with the two-photon 
laser by using the near-infrared branding (NIRB) technique8. The 
use of these NIRB marks to indicate the region of interest allows 
optimal fixation and staining methods to be used, giving well-
preserved and contrasted cell structures.

In comparison to the previous correlative method using trans-
mission EM for analyzing in vivo–imaged neurites3, this approach 
with FIBSEM is more reliable as there is no handling of fragile 
ultrathin serial sections that may break or become contaminated 
during the staining process. The imaging occurs entirely in the 
microscope, and the entire series, acquired automatically, has 
near-isotropic voxels with which segmentation software can help 
to reconstruct the features of interest9,10.

FIBSEM imaging does, however, have a limited field of view 
with a maximum imaging area of ~20 µm × 20 µm achieva-
ble when very precise milling depths across the entire face are 
required. The alternative serial block-face scanning method that 
uses a diamond knife to remove layers11 can be used to image far 
larger areas (114 µm × 132 µm), although only to a minimum 
section thickness of ~25 nm (ref. 12). Both of these methods 
destroy the imaged region and thus give only a single opportu-
nity to obtain the best image series. TEM, in contrast, is non-
destructive, and the same region can be imaged repeatedly at  
different magnifications.

Experimental design 
The procedure starts after the completion of in vivo imaging1 
of axons and dendrites. It describes how the tissue is prepared, 
and the same neurites that had been identified are then imaged 
with EM. The procedure can be applied to any of the fluorescent 
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structures that were imaged with light microscopy as long as they 
can be seen in the tissue after the fixation step.

Localizing the previously imaged neurites in the fixed tissue.  
For EM analysis of in vivo–imaged structures, the mouse should 
be imaged immediately before perfusion fixation and a low-
magnification image of the brain’s surface vasculature is acquired 
through the cranial window5 (Fig. 1). The image of the vascula-
ture is an important map for locating the region where the neu-
rons of interest can be found. This pattern of vessels is seen in 
the first tangential vibratome sections that are cut from the fixed 
brain at the position of the cranial window. These sections are 
photographed, the images are aligned and, by comparing these 
with the live image of the surface vasculature, the exact location of 
the imaged neuron is found. The identified section, containing the 
neurites of interest, is then imaged with the two-photon micro-
scope, and a laser is used to burn fiducial NIRB marks, which will 
be visible with transmitted light microscopy once the tissue has 
been stained and embedded in resin. These laser-branding marks 
cause autofluorescence and need to be imaged, as soon as they 
are made, through the depth of the section so that their precise 
location is known relative to the required axons and dendrites. As 
the embedding process of this section will remove any remaining 

fluorescence, these fiducial marks are crucial for correctly posi-
tioning the block for FIBSEM.

NIRB technique. Two sets of NIRB marks are made in the section. 
The first are burned at a depth of 4–6 µm above the neurites of 
interest (Fig. 1d), forming a square shape of 15–20 µm in length. 
The second set of laser marks are burned on the section surface as 
an asymmetric shape, 100 µm in length and around the first small 
laser marks. These second marks are then easily seen with a low-
power (×5) objective in the transmitted light microscope. They 
serve to indicate the approximate location of the small marks, 
highlighting the position of the neurites of interest. The shape of 
these fiducial marks ensures that the orientation of the neurites 
is easily recognized during the block-making process, and their 
height in the section helps the block to be trimmed close to these 
features without removing them.

The original description of this laser-branding method used 
photoconversion of 3, 3-diaminobenzidine tetrahydrochloride to 
form a dense precipitate of the NIRB marks to help locate them in 

a b

c d

Figure 1 | Two-photon in vivo imaging and fiducial laser-branding marks. 
(a) Blood vasculature of the cortical surface as seen through the cranial 
imaging window. (b) The pattern of the blood vessels (white dashed lines) 
is used to locate the region of interest in the two-photon image. (c) High-
magnification image of tdTomato-labeled GABAergic axons and dendrites 
shown in the white square in b. White square in c indicates the region of 
interest. (d) After fixation and vibratome sectioning, the section containing 
the region of interest was identified, and a two-photon laser was used to 
burn fiducial laser marks (white arrowheads) around the structure of interest. 
Note that the TdTomato-positive neurites are not clearly visible at the end 
of the procedure owing to photobleaching caused by previous imaging. Scale 
bars are 50 µm (a,b), 5 µm (c) and 25 µm (d). Experiments using animals 
were carried out under institutional and national ethics guidelines.
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Figure 2 | Block preparation for the FIBSEM. (a) Fixed-vibratome section 
processed for EM and resin-embedded with clearly visible fiducial laser 
marks inside the tissue (white arrowheads). (b) A laser dissecting 
microscope is used to replicate the original NIRB marks on the top surface 
of the resin-embedded sample to facilitate the trimming process. (c) The 
piece of resin containing the NIRB marks is cut from the section and glued 
onto a flat slab of empty resin. (d) One side of this slab is trimmed away 
until the NIRB marks lie at the edge. Steps are cut on either side of this 
region to expose the region of interest, and two score marks are made down 
this front edge (arrowheads) as additional fiducial marks to locate region 
of interest inside FIBSEM. (e,f) The block is positioned in the jaws of a 
ultramicrotome holder to allow excess resin, above the NIRB marks,  
to be removed with the glass knife. (g) The block is then glued on an 
inclined aluminum SEM stub and coated with a thin protective layer of gold 
(~30 nm). The red dotted circle indicates the position of the final trimmed 
block face (enlarged in h). (h) The stub is placed inside the FIBSEM, and 
the focused ion beam is oriented parallel to the block face, which is parallel 
to the plane of the NIRB marks. The electron beam is 54° relative to the 
milling ion beam. Scale bar in a is 25 µm. Experiments using animals were 
carried out under institutional and national ethics guidelines.
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the resin8. This step is omitted here, as the marks are clearly visible 
in resin without further enhancement (Fig. 2a). However, the 
sections are cut no thicker than 60 µm. Thicker sections cannot 
be adequately illuminated in the light microscope once they have 
been stained and resin-embedded. If the sections are too thick, the 
densely labeled tissue will obscure the NIRB marks.

The chemical fixation of the fluorescent tissue also renders 
any fluorescent structures susceptible to bleaching. Therefore, it 
is important that all imaging be performed as rapidly as pos-
sible to acquire information about the positions of these struc-
tures in relation to the NIRB marks as well as in relation to other 
structures such as cell bodies and blood vessels. As the smaller 
NIRB marks are the most crucial, these need to be made first to 
decrease the chances of fluorescence bleaching. As fluorescence 
is also attenuated by the fixed tissue, the image quality may be 
poor. However, it is only necessary to acquire images that show 
the position of the neurites in relation to the marks. The neurites 
themselves do not need to be identifiable at this stage.

Preparation for FIBSEM. The EM embedding part of the proto-
col produces highly contrasted membranes. However, although 
there are many variations of stains that can be used, this par-
ticular recipe will still allow the NIRB marks to be seen easily in 
the transmitted light microscope. If more contrast were needed, 
then it would be necessary to cut thinner vibratome sections and 
increase the membrane contrast by increasing the staining times. 
However, these sections will be more fragile and break more easily 
during resin-embedding.

Once the resin has hardened, the block containing the section 
is then trimmed and is ready for FIBSEM. To help with this trim-
ming process, a dissecting laser is used to etch the surface of the 
resin to indicate the position of the NIRB marks in the embed-
ded tissue below (Fig. 2b). These surface marks are easily visible 
under the stereomicroscope and act as guides when this region is 
cut away from the rest of the section to be mounted on a 1-mm-
thick resin slab (Fig. 2c). This provides a solid support and allows 
the sample to be easily manipulated when it is mounted on the 
ultramicrotome. The etched marks on the surface can be seen at 
all times during the trimming process and help to avoid accidental 
removal of the required region.

The goal of the trimming process is to expose the smaller NIRB 
marks to the point where they lie at the edge of the block and are within 
3–4 µm of its surface (Fig. 2d–f). This is achieved by completely  
removing all the resin from one side of the sample up to and 
including the edge of the smaller NIRB marks. This creates one side 
of the block at 90° to the plane of the section (Fig. 2d). Next, the 
top surface of the sample is trimmed away, parallel to the section,  
a few micrometers at a time, until the NIRB marks are 3–4 µm  

from the surface (Fig. 2e,f). The precision of this trimming process 
helps to minimize the time for which the focused ion beam is used 
to mill away material before any imaging is performed.

Throughout the trimming, a transmitted light microscope is used 
to repeatedly check the position of the NIRB marks inside the block. 
At this point, any other features in the tissue, such as blood vessels, 
lying close to the region of interest are noted. These can be useful 
fiducial marks that may appear during the initial preparation with 
FIBSEM and are used as indicators of where the marks lie.

The final block is then mounted onto a 45° inclined aluminum 
SEM stub (Fig. 2g). This angle means that the sample is pre-tilted 
in the microscope, with the microscope stage being used to attain 
the final exact position for imaging.

FIBSEM approach. The block is imaged inside the focused ion 
beam (FIB) scanning electron microscope (for example, Zeiss 
NVision 40) with the FIB milling the face parallel to the NIRB 
marks and, therefore, the plane of the section (Figs. 2h and 3a,b). 
The initial imaging face made by the ion beam, with a milling cur-
rent of 1.5–13 nA, is much larger (60–80 µm) than the region of 
interest. This quickly reveals the underlying tissue. At this point, 
the coordinates measured during the block-preparation phase, 
which pinpoint the exact position of the underlying NIRB marks, 
are used to determine where imaging will occur. As the marks lie 
close to the edge of the block, the protective 1-µm-thick layer 
of platinum (or carbon) can immediately be deposited on the 

54°

e– beamIon beam

c

b

aFigure 3 | Imaging the region of interest with FIBSEM. (a) A model showing 
the orientation of the block inside the FIBSEM with the electron and ion 
beams. (b) Secondary electron image of the block before milling (in the same 
orientation as the model in a). The score marks at the edge of the block are 
clearly visible (black arrowheads) (also in a) and indicate the position along 
the face at which the NIRB marks will be found (white arrowheads in a and c).  
(c) Back-scattered electron image of the milled face exposing the NIRB 
marks inside the resin (white arrowheads). The shape of these marks is also 
seen in the two-photon image of the same region in the fixed-vibratome 
section (inset). Scale bar in b is 500 µm, in c it is 20 µm and in c inset it is 
10 µm. Experiments using animals were carried out under institutional and 
national ethics guidelines.
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top face by using a gas-deposition system. Here, a precursor gas 
is ionized with the FIB to leave a metal deposit on the surface 
below. This layer serves as a hard, even crust along the top edge 
of the imaged face that ensures even milling. This reduces mill-
ing artifacts such as the curtaining effect, which is seen as vertical 
streaks running down the imaging face. Once the exact position 
of the imaging window is selected (Fig. 3c), the FIB is then used 
to make the final polish at a low milling current of ~700 pA. The 
machine is then left unattended for ~2 h to allow any thermal or 
mechanical drift to dissipate.

A series of images is collected automatically from the FIB scan-
ning electron microscope during a single run. Any interruption 
to this imaging procedure will cause irregular thicknesses to be 
removed by the milling beam. It is crucial, therefore, that the 
microscope be left undisturbed as much as possible, with only 
brief checks of the focus and astigmatism. The imaging param-
eters used are magnifications of ~5–6 nm per pixel, at an accel-
eration voltage of 1.3–1.5 kV and with a current of between  
800 pA and 1,000 pA. The dwell time is optimized to maintain 
the milling/imaging cycle to below 2 min. This allows consistent 
milling depths as the block face reaches a steady-state thermal 
equilibrium. The FIB is set to mill 5–10 nm from the surface of 
the block after each image. However, because of a certain amount 
of thermal drift of the sample forward or backward, which can 
alter the section thickness, the actual distance between each image 
is calculated after imaging is finished by using the cylindrical 
diameters method13. Briefly, the section thickness is calculated 
by dividing the number of images across which a longitudinally 
milled mitochondrion is seen by its maximum diameter. This is 
repeated through the entire stack on >40 mitochondria.

Image segmentation and 3D reconstruction
Although FIBSEM can be used to remove thicker layers from 
the imaging face during each cycle, and therefore capture vol-
umes faster, it is important to acquire images with small Z steps. 
This optimizes the segmentation performance of the algorithms 

used to reconstruct the neurites, speeding up the reconstruction  
process with fewer errors. By using the ilastik program9,10  
(http://ilastik.org/; Fig. 4), the different axons and dendrites  
are selected by scribbling their inner regions on a single image 
(intercellular space and organelles), and also by indicating the 
background or the regions that are not part of the reconstruction. 
The program grows these seeds until they fill the entire volume 
within less than a second. The resulting segmentation can then 
be refined or corrected by placing additional seeds at any time. To 
indicate how quickly reconstruction can be completed, the total 
time to reconstruct the volume of 15.00 µm × 15.00 µm × 13.10 µm  
and dendrites and axons in a stack containing 1,505 images was 
2 h. The final 3D model can then be exported to 3D modeling 
software (Blender, http://www.blender.org/) for measurements 
and rendering (Fig. 4e).

e

c

ba

d

x-y plane

x-z plane

Figure 4 | Segmentation and 3D reconstruction. (a) The ilastik program was 
used for interactive seeded watershed segmentation of the structures of 
interest. An image from the stack shows yellow marks made by the user to 
indicate the structure of interest (object) and red marks for the background. 
(b) On the basis of these ‘seeds’, the segmentation process proceeds 
automatically through the entire image stack. x-y (top) and x-z (bottom) 
views of the segmented piece of dendrite (in yellow). (c,d) The 3D model  
is then generated automatically (c) and can then be compared with the  
in vivo image (d). (e) The final 3D model of the tdTomato-labeled GABAergic 
axons (gray) and dendrites (yellow) can then be rendered and visualized with 
Blender rendering software. Scale bar in a is 1 µm, and in d it is 5 µm.  
Images in panel b are at the same scale as panel a. Experiments using 
animals were carried out under institutional and national ethics guidelines.

MATERIALS
REAGENTS
Fixation reagents

Anesthetized mouse containing a cranial window (see ref. 1 for further 
details) ! CAUTION Adhere to all institutional and national ethics guidelines 
for animal experiments. 
Agarose (Eurobio, cat. no. GEPAGA 07-64)
Glutaraldehyde (25% (vol/vol) EM grade; EMS, cat. no. 16220)  
! CAUTION It is toxic on inhalation and skin contact. Wear gloves and  
eye protection, and always work in a fume hood.

•

•
•

Paraformaldehyde (EMS, cat. no. RT 19208) ! CAUTION It is an irritant on 
inhalation and skin contact. Wear gloves and eye protection, and work in a 
fume hood.
PBS
Disodium hydrogen phosphate (Na2HPO4; Sigma-Aldrich, cat. no. 71642)
Sodium dihydrogen phosphate (NaH2PO4; Sigma-Aldrich, cat. no. 71496)
Sodium cacodylate (Sigma-Aldrich, cat. no. 20840) ! CAUTION It acts  
as an irritant on inhalation and skin contact. Wear gloves and work in a  
fume hood.

•

•
•
•
•

http://ilastik.org/
http://www.blender.org/
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Osmium tetroxide (OsO4; EMS, cat. no. RT 19110) ! CAUTION It is a highly 
toxic, volatile chemical that is strongly oxidizing, is fatal if swallowed or 
inhaled, and causes severe irritation to eyes, skin and respiratory tract. 
Avoid all direct skin contact and inhalation; wear gloves and eye protection, 
and work only in a fume hood. To handle any solution containing OsO4, 
only use glassware (glass Pasteur pipettes, glass scintillation vials and glass 
measuring cylinders).
Potassium ferrocyanide (K4Fe(CN)6·3H2O; Sigma-Aldrich, cat. no. 455989) 
! CAUTION It is a harmful reagent and is an irritant on inhalation and skin 
contact. Wear gloves and eye protection, and work in a fume hood while 
handling it.
Uranyl acetate (Sigma-Aldrich, cat. no. 73943 FLUKA) ! CAUTION This is a 
radioactive and light-sensitive reagent. It is toxic on inhalation. Wear gloves 
and work in a fume hood while handling it. Appropriate institutional safety 
guidelines and regulations must be met.

EM dehydration and embedding
Ethanol (Merck, cat. no. 1.00983.2500) ! CAUTION It is flammable.  
Wear gloves.
Double-distilled water (ddH2O)
Durcupan resin: four components supplied separately: single component A,  
M epoxy resin (Sigma-Aldrich, cat. no. 44611), single component B,  
hardener (Sigma-Aldrich, cat. no. 44612), single component D,  
plasticizer (Sigma-Aldrich, cat. no. 44614), and DMP-30, accelerator  
(EMS, cat. no. RT 13600) ! CAUTION This resin is toxic on inhalation and 
skin contact. Wear gloves and eye protection, and work in a fume hood 
while handling it.

EQUIPMENT
In vivo imaging and generation of laser fiducial marks

Microscope slides (Thermo Scientific, cat. no. 10143562CE)
Coverslips
Syringe with 23-gauge needle (Polymed Medical Center, cat. no. 03.341.01)
Two-photon laser scanning microscope equipped with a pulsed laser  
(we used a custom-built microscope and a femtosecond-pulsed titanium-
sapphire laser (Chameleon Ultra II, Coherent))
Nail polish
Parafilm M (Fischer Scientific, cat. no. 13-374-10)
Imaging chamber (made of three layers of Parafilm spacer, size of coverslip, 
placed on glass microscope slide and sealed from outside with nail polish)

Perfusion fixation
Surgical scissors
Forceps
Dissecting board (polystyrene lid)
Ampoule cracker (EMS, cat. no. 60605-10)
Perfusion needle (1-inch Straight Cannula Blunt End Tip, 15 gauge;  
Fisnar, cat. no. 5601137)
Perfusion peristaltic pump (Witec, cat. no. PK100)

Vibratome sectioning
Histology plastic embedding molds, 22 × 22 mm (EMS; cat. no. 70182)
24-well culture dish (Nunc, cat. no. 142475)
Glass scintillation vials, 20 ml (EMS, cat. no. 72634)
Surgical scissors
Forceps
Paint brush, size 6
Vibratome (Leica VT1200S, Leica Microsystems)
Wooden cocktail sticks
Cyanoacrylate glue
Single-edged razor blades (EMS, cat. no. 71950) ! CAUTION Sharp blade, 
avoid injury.

EM embedding
Wooden cocktail sticks
Glass scintillation vials, 20 ml (EMS, cat. no. 72634)
Rotating mixing wheel
Ampoule cracker (EMS, cat. no. 60605-10)
Microscope slides (Thermo Scientific, cat. no. 10143562CE)
Mold-separating agent (Glorex, cat. no. 62407445)
Ultrasonic cleaner (VWR International, cat. no. 142-6044)
Tri-corn beaker, 100 ml (EMS, cat. no. 60970)
Glass Pasteur pipettes, 150 mm (VWR International, cat. no. 612-1701)
Plastic Pasteur pipettes, disposable, 3 ml (Brand, cat. no. 747760)
Single-edged razor blades (EMS, cat. no. 71950) ! CAUTION Extremely sharp 
blade; avoid injury.

•

•

•

•

•
•

•
•
•
•

•
•
•

•
•
•
•
•

•

•
•
•
•
•
•
•
•
•
•

•
•
•
•
•
•
•
•
•
•
•

Block preparation
Stereomicroscope (Leica M205 C, Leica Microsystems)
Laser dissecting microscope (Leica LMD, Leica Microsystems)
Single-edged razor blades (EMS, cat. no. 71950) ! CAUTION Extremely sharp 
blade, avoid injury.
Jeweler’s saw (EMS, cat. no. 72009)
Fine-toothed rasp
Dust-off can (CRC Industries, cat. no. 207936041201)
Flat slab of blank resin, 1 mm thick. (This is prepared by pouring  
fresh Durcupan resin between two glass slides held 1 mm apart.  
The exact spacing is achieved by using other glass slides sandwiched  
in this space. All slides are coated with mold-separating agent. Avoid  
introducing any air bubbles and polymerize in a 65 °C oven. Remove  
the polymerized slab from between the glass slides with a razor blade.)  
! CAUTION Extremely sharp blade and high risk of breaking the glass  
slides when disassembling the casting frame. Wear eye protection and  
avoid injury.
Tweezers
Glass knife maker (Leica EM KMR3, Leica Microsystems)
Glass strips (Leica, 400 × 25 × 8 mm, cat. no. 840032)
Ultramicrotome (Leica Ultracut UCT, Leica Microsystems)
Transmitted light microscope (Axioscope 2 Plus, Zeiss) equipped with 
digital camera (AxioCam HRc, Zeiss)
Computer

FIBSEM stub preparation
12.5-mm aluminum SEM stub for mounting resin block, with 45° chamber 
(Agar Scientific, cat. no. G3020)
Carbon conductive cement (CCC carbon adhesive, EMS, cat. no. RT12664) 
! CAUTION It is highly flammable, is harmful by inhalation and in contact 
with skin, and is an irritant to eye and skin. Wear gloves, eye protection and 
mask, or use a fume hood while handling it.
Wooden cocktail sticks
Tweezers
Gold coater (Cressington vacuum evaporation system)

FIBSEM imaging and 3D reconstruction
FIBSEM microscope (Zeiss NVision 40, Carl Zeiss SMT)
Fiji software package (http://fiji.sc/wiki/index.php/Fiji)
Image manipulation software, e.g., Photoshop (http://www.adobe.com/) or 
ImageJ (http://rsbweb.nih.gov/ij/) or GIMP (http://www.gimp.org/)
ilastik software (version 0.5.12; http://ilastik.org/)
Blender software (version 2.66; Blender Foundation; http://www.
blender.org/).
Powerful computer with a good graphics card and sufficient RAM memory 
(>8 GB) by using either Linux or MacOSX operating system

REAGENT SETUP
Phosphate buffer (0.2 M stock solution)  Prepare aqueous stock solution A 
(0.2 M NaH2PO4) and stock solution B (0.2 M Na2HPO4). For 100 ml  
phosphate buffer (PB), mix 19 ml of solution A and 81 ml of solution B, 
check and adjust the pH to 7.4 if necessary. Store the buffer at 4 °C,  
and use it within a week.
PBS (0.01 M, 0.9% (wt/vol) NaCl)  For a final volume of 1 liter of PBS, mix 
50 ml of 0.2 PB with 950 ml of ddH2O and add 9 g of NaCl to it. Store the 
saline at 4 °C, and use within a week.
Cacodylate buffer (0.2 M stock solution)  Add 10.8 ml of 0.2 M HCl to  
100 ml of 0.4 M solution of sodium cacodylate (8.56 g in 100 ml of ddH2O). 
Adjust the pH to 7.4 and make up to 200 ml of final volume with ddH2O. 
Store the buffer at 4 °C indefinitely.
Fixative solution (2.5% (vol/vol) glutaraldehyde and 2% (wt/vol)  
paraformaldehyde in 0.1 M PB, pH 7.4)  Prepare solution immediately  
before use. Dissolve 6 g of paraformaldehyde in 100 ml of ddH2O heated  
to 65 °C. Add 1–2 drops of 5 M sodium hydroxide and stir with magnetic 
stirrer on a heated stirrer until all deposits have dissolved and the solution  
is clear. Add dissolved paraformaldehyde to 100 ml of cold 0.2 M PB,  
followed by 30 ml of freshly opened 25% (vol/vol) aqueous glutaraldehyde, 
by using an ampoule cracker. Adjust the pH to 7.4 and add ddH2O up to a 
final volume of 300 ml. Leave it to cool to 20 °C before use.
OsO4 stock solution (2% (wt/vol) in ddH2O)  Open sealed ampoule of 1 g 
of OsO4 crystals by using an ampoule cracker and dissolve them in 50 ml of 
ddH2O. The solution must be stored under a fume hood in a double-sealed 
container at 4 °C and can be used within a few months.

•
•
•

•
•
•
•

•
•
•
•
•

•

•

•

•
•
•

•
•
•

•
•

•

http://fiji.sc/wiki/index.php/Fiji
http://www.adobe.com/
http://rsbweb.nih.gov/ij/
http://www.gimp.org/
http://ilastik.org/
http://www.blender.org/
http://www.blender.org/
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OsO4 (1% (vol/vol)) and potassium ferrocyanide (1.5% (wt/vol)) in 0.1 M 
cacodylate buffer  Mix 5 ml of 2% aqueous OsO4 with 5 ml of 0.2 M  
cacodylate buffer and dissolve 0.15 g of potassium ferrocyanide.  
Always prepare this solution fresh.
OsO4 (1% (vol/vol)) in 0.1 M cacodylate buffer  Add 5 ml of 2% aqueous 
OsO4 to 5 ml of 0.2 M cacodylate buffer. Always prepare this solution fresh.
Uranyl acetate (1% (wt/vol) in ddH2O)  To 10 ml of ddH2O, add 0.1 g of 
uranyl acetate and agitate until dissolved or use water bath sonicator at  
maximum speed for ~5–10 min. Always prepare this solution fresh.
Durcupan resin  Weigh 33.3 g of single component A (M epoxy resin),  
33.3 g of single component B (hardener) and 1 g of single component D 

(plasticizer) into a 100-ml Tri-corn beaker and stir with magnetic stirrer for 
30 min. Add 1 g of DMP-30 (accelerator) and stir for additional 20–30 min.  
In any stage of mixing, avoid air bubble formation. Unused resin can be 
stored in a sealed 20-ml syringe at −20 °C for 2 weeks. ! CAUTION Handle 
resins and their components only in a fume hood.
Mold-separating agent–coated slides  Dip each cleaned glass microscope 
slide completely into mold-separating agent solution. Take the slide out 
of the solution and place in a slide-drying rack in a 60 °C oven for 2 h. 
Repeat the coating process a second time and let the slides completely  
dry in a 60 °C oven for 24 h. Store coated slides in a dust-free container 
until needed.

PROCEDURE
Fixation and vibratome sectioning ● TIMING 3–4 h
 CRITICAL This procedure starts after the acquisition of in vivo images of axons and dendrites through a mouse cranial 
window, as described by Holtmaat et al.1. The animal is maintained under heavy anesthesia throughout. The handling of mice 
used in these experiments adhered to all institutional and governmental animal ethics guidelines for experimentation.
1|	 Take a low-magnification image of the blood vessel pattern through the cranial window by using transmitted light  
(Fig. 1a). Ensure that the position of the fluorescent structures is known relative to these blood vessels.

2|	 Fix the forelimbs of the deeply anesthetized animal to the dissection board.

3|	 Open the chest cavity with scissors and forceps to expose the heart and lungs.

4|	 Insert the perfusion needle into the left ventricle toward the aorta and fix the needle in place with the heart clamp.

5|	 Switch on the peristaltic pump and flush the animal with 10 ml of isotonic PBS at a speed of 12 ml min−1. Filling the 
tubing first with fixative, then backfilling with PBS from the needle end ensures a smooth transition between the two  
perfusates, rather than using a three-way tap and switching between different sources.

6|	 Immediately perfuse the whole animal with 300 ml of 2.5% (vol/vol) glutaraldehyde and 2% (wt/vol) paraformaldehyde 
in 0.1 M PB (pH 7.4). The perfusion fixation should be complete within 25–30 min.
 CRITICAL STEP As a quality check of perfusion, monitor color change of the liver. It should change to light brown within 30 s.
? TROUBLESHOOTING

7|	 Leave the animal for a further 2 h to complete the fixation process.

8|	 Remove the fixed brain from the skull by carefully peeling away the skull with forceps, and place it in 0.01 M PBS.

9|	 Fill the histology plastic mold with 5% (wt/vol) of agarose solution at 50 °C in PBS, allowing it to cool to ~30°C but 
ensuring that it remains liquid.

10| Immerse the brain in the molten agarose and orient it so that the region imaged via the imaging window is parallel to 
the surface.

11| Place the mold containing the agarose-embedded brain in a refrigerator (at 4 °C) for 10 min.

12| Remove the solidified agarose block from the mold, and trim with a razor blade to leave a minimal amount of agarose 
around the brain.

13| Mount the trimmed block onto the vibratome support table with cyanoacrylate glue, ensuring that the imaged region is 
uppermost and parallel to the upper surface.

14| Cut 60-µm-thick vibratome sections in PBS, and transfer them into a 24-well culture dish by using a paint brush.

Locating the axons and dendrites of interest in the fixed sections ● TIMING 30 min
15| Image each vibratomed section at low magnification (12–16 time magnification) by using the dissecting microscope. 
Blood vessels are best seen by using oblique illumination directed from below.
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16| Superimpose and align the images of the sections. These will reveal the blood vessel pattern on the brain’s surface. This is the 
same pattern that is seen in vivo (captured at Step 1). The alignment of these images is carried out by using image manipulation 
software, e.g., Photoshop, ImageJ or GIMP to identify the section containing the region previously imaged in vivo. The position of 
the neurites of interest is located according to blood vessel pattern. This indicates in which section the neurites can be found.

17| Mount the identified section inside an imaging chamber made from a sheet of Parafilm, with a rectangle cut out of its 
center, placed under a coverslip. Flood the chamber with PBS.
 CRITICAL STEP Avoid any air-bubble formation, minimize light exposure and do not allow the section to dry.

Generating laser fiducial (NIRB) marks around the region containing the axons and dendrites of interest ● TIMING 30 min
18| Locate the previously imaged neurites (Fig. 1a,b) with the two-photon microscope. The image of the blood vessels 
from the section, and from the cranial window, will indicate exactly the position to find the fluorescent structures.

19| Tune the two-photon laser wavelength, λ, to 850 nm and laser power to ~300 mW at the back focal plane of the objective.

20| Use between 512 and 2,500 line scans at a speed of 2 ms per line to burn fiducial mark lines.
 CRITICAL STEP Control the size of the laser mark by using the auto-fluorescence generated from its edges as a guide. 
The wider the laser burns, the further apart the two fluorescent edges. If the two edges appear to be closer than 2 µm, 
then the mark will likely be invisible in the embedded section. During the line scans, turn the photomultipliers to a lower 
offset to prevent damage resulting from over-illumination. The relationship between the level of auto-fluorescence from 
line scans and the width of the laser marks should be determined empirically and can be tested on redundant sections.

21| Make a rectangle or square around the neurites of interest with a size of 15–24 µm along one edge. The marks should be 
placed 3–5 µm above the neurites of interest and not at the same Z height.

22| Image these smaller marks with the neurites enclosed through the depth of the section at a wavelength of λ = 910 nm 
and at high-magnification settings (e.g., image size of 0.2 µm per pixel and 2 µm steps in the Z direction).

23| Make an asymmetric shape (i.e., trapezium) around the first NIRB marks with a size of ~50–100 µm along any side (Fig. 1d).

24| Image these larger marks at a lower magnification with the two-photon microscope.

25| Image the laser marks by using transmitted light microscopy, including other features such as blood vessels and  
myelin bundles.
 CRITICAL STEP For future reference and correlation with FIBSEM, always collect two-photon image stacks before and  
after laser branding at both high and low resolution.
 PAUSE POINT Fixed sections can be stored in 0.1 M sodium cacodylate buffer at 4 °C overnight.

Staining for EM and resin-embedding ● TIMING 7–9 h (excluding resin polymerization)
26| Transfer sections into a 20-ml glass scintillation vial with a paint brush.

27| Wash the sections in 0.1 M sodium cacodylate buffer (pH 7.4) for five washes of 5 min each wash, gently agitating 
closed vials on a rotating mixing wheel at a speed of ~4 rev min−1. Agitate in this way for each of the following steps until 
the end of Step 36.
? TROUBLESHOOTING

28| Postfix and stain in 1% (vol/vol) OsO4 and 1.5% (wt/vol) ferrocyanide in 0.1 M sodium cacodylate buffer (pH 7.4) for 40 min.
? TROUBLESHOOTING

29| Postfix and stain in 1% (vol/vol) OsO4 in 0.1 M sodium cacodylate buffer (pH 7.4) alone for 40 min.
? TROUBLESHOOTING

30| Wash the sections in ddH2O twice for 5 min each wash.

31| En bloc stain the section in 1% (wt/vol) uranyl acetate in ddH2O for 40 min.
? TROUBLESHOOTING
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32| Wash the sections in ddH2O for 5 min.
 PAUSE POINT Post-stained sections can be stored in ddH2O at 4 °C overnight.

33| Dehydrate the sections in a graded alcohol series (vol/vol): 2 × 50%, 1 × 70%, 1 × 90%, 1 × 95% and 2 × 100% ethanol 
for 3 min each change.
 CRITICAL STEP Always prepare fresh solution immediately before use and prevent exposing sections to air at any time  
during the dehydration process. After dehydration, sections become brittle; therefore, handle them carefully.

34| Infiltrate the sections in 50% (vol/vol) Durcupan in ethanol for 30 min.

35| Infiltrate the section for 2 × 30 min with fresh Durcupan. Use fresh Durcupan for each change.

36| Replace with fresh Durcupan and leave for 2–4 h.
 CRITICAL STEP Extending the infiltration time will increase the viscosity of the resin.

37| Transfer and arrange section(s) onto glass slide coated with mold-separating agent by using the wooden cocktail stick. 
Fill the edges of the slide with a small amount of resin, place the label using a pencil and carefully cover with second coated 
glass slide to make a flat sandwich.
 CRITICAL STEP Do not try and readjust the position of the section once the sandwich has been made, as this risks breaking 
the section.
? TROUBLESHOOTING

38| Polymerize the flat-embedded sections in a 65 °C oven for 24 h. When the resin is completely cured, separate the glass 
slides from the resin by using the edges of the razor blade.
 PAUSE POINT Cured resin-embedded sections can be stored at room temperature (~20–25 °C) for an unlimited period of time.

Preparation and trimming of the block face ● TIMING ~2–5 h 
39| Locate the laser marks in the resin-embedded section by using a light microscope (Fig. 2a).
? TROUBLESHOOTING

40| Replicate the original NIRB marks on the section surface with the pulsed laser of the laser dissection microscope (Fig. 2b).
 CRITICAL STEP The etched marks on the surface of the resin are visible with the stereomicroscope fitted to the  
ultramicrotome during the subsequent trimming process. These marks also eliminate the need to remove the block from  
ultramicrotome to check the position of the region of interest inside the tissue.
? TROUBLESHOOTING

41| Wash the resin-embedded section with ddH2O, and wipe it clean with soft tissue to remove any traces of mold- 
separating agent.

42| Make a 4 mm × 20 mm strip of 1-mm-thick slab of blank resin with a jeweler’s saw, smooth the edges using the fine rasp 
and remove all dust with compressed air.
 CRITICAL STEP The slab of blank resin gives a solid support and ensures easy manipulation during the trimming process.

43| Wash the slab with ddH2O, and wipe it with clean soft tissue to remove any traces of mold-separating agent.

44| Trim away the region marked by the laser dissection microscope from resin-embedded section with single-edged razor blade, and 
glue it to the slab of blank resin (Step 42) using a small droplet of Durcupan resin (Fig. 2c) under the dissecting stereomicroscope.

45| Place the slab with cut region into a 65 °C oven for at least 5 h, preferably overnight.

46| Mount the block in the ultramicrotome so that the embedded section (and the NIRB marks) is vertical. Set the edge of 
the glass knife parallel to the edge of this resin block and trim away the block, and embedded section, until the NIRB marks 
are close (<10 µm) to this cut edge.
 CRITICAL STEP Check the distance of the NIRB marks to the edge by removing the block from the holder and placing it in 
the light microscope.

47| Place the block back in the ultramicrotome and rotate until the section is horizontal (Fig. 2d). Trim a step into the right 
side of the face (<60 µm from the NIRB marks) by using the edge of a new glass knife close to within <50 µm of the edge of 
the NIRB marks (Fig. 2d).
? TROUBLESHOOTING
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48| Optionally, a second indentation can be made on the left side of the NIRB marks by rotating the sample holder 180°.
 CRITICAL STEP Indentations made on either side of the NIRB marks serve as fiducial marks from which measurements can 
be made to precisely position the FIBSEM imaging window. Additional score marks can also be made down the face of the block 
with the left corner of the glass knife (Fig. 2d) to serve as additional fiducial marks to precisely pinpoint the region of interest.
? TROUBLESHOOTING

49| Measure the depth of the NIRB marks inside the resin from the block’s surface by using the transmitted light microscope 
equipped with a calibrated focusing stage.
 CRITICAL STEP After each trimming step, take calibrated images to record how far the NIRB marks are from the block edge 
and its surface.

50| Clamp the block in the ultramicrotome so that the glass knife can trim the block’s surface parallel to the NIRB marks. 
Trim away the resin until ~5 µm of resin remains about the NIRB marks (Fig. 2e,f).
 CRITICAL STEP Take care to trim only small amounts of resin at a time (<2 µm), checking the depth of the NIRB marks in 
the light microscope.

Mounting the block to SEM stub and gold coating ● TIMING ~1.5 h
51| Take an image of this final block in the light microscope (×20 objective). Ensure that it shows the position of the NIRB 
marks inside the tissue, relative to the block edge, steps cut on either side and the score marks on the block edge (Fig. 3a). 
The overlay and alignment of the final block image with both low-resolution two-photon image of the laser marks and  
high-resolution image of the structure of interest is later used to position the final imaging window for FIBSEM imaging.

52| Glue the block to the inclined (45°) surface of the 12.5 mm SEM aluminum stub by using carbon-conductive cement  
applied with a wooden cocktail stick. Position the block so that the edge to be imaged lies at the stub’s center (Fig. 2g). 
Allow the cement to dry completely (<30 mins).

53| Coat the final block face with a 30-nm layer of gold by using a vacuum evaporation unit.
? TROUBLESHOOTING
 PAUSE POINT The gold-coated block can be stored indefinitely in a desiccator until needed.

FIBSEM imaging face preparation and image acquisition ● TIMING ~2 h and 48–72 h
54| Insert the sample inside the FIBSEM microscope (e.g., Zeiss NVision 40).

55| Orient the block so that its upper face, parallel with the NIRB marks, is parallel to the ion beam, and therefore at 54° to 
the electron beam (for Zeiss microscopes). This upper face is the ‘imaging face’ (Fig. 3a,b).

56| Measure the position along the imaging face at which the NIRB marks are found.

57| Ion-beam mill the imaging face with a current of ~6 nA so that a 60-µm-wide portion of the underlying resin is  
revealed. This may reveal some underlying features that may help in positioning the imaging window more precisely.

58| Deposit a 1-µm-thick protective layer of platinum (or carbon) on the top surface of the block, above the region of  
interest. This is done by using the ion beam in conjunction with the gas injection system.

59| Polish the imaging face with a lower current of ~0.7–1.5 nA until all blemishes and imperfections have been removed, 
and the beam is milling the face consistently.

60| Stop milling and leave the microscope unattended for at least 2 h.
? TROUBLESHOOTING

61| Select a region to image, of ~15 µm × 10 µm in size and estimated to be situated in line with the NIRB marks,  
to capture the neurites of interest (Fig. 3c).

62| Select an ion beam current of 700 pA with a voltage of 30 kV and an imaging voltage of 1.5 kV, ~800 pA with a grid  
tension on the energy selective back-scattered (ESB) detector of 1.3 kV allowing for an energy loss of 200 eV.

63| Mill a window that is three times wider than the area to be imaged, i.e., 45 µm. Capture images with pixel sizes of 4–5 nm 
with pixel dwell times of ~10 µs, and a milling thickness between images of 5–10 nm. Use the microscope’s focus and image-
tracking functions (dynamic focus and TrackWD on the Zeiss NVision) so that the electron beam is properly focused on the tilted 
sample surface and follows the retreating face of the block. Tilt correction should be applied during the acquisiton of the SEM 
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image so that the generated image will already be corrected for the foreshortening effect when imaging the tilted plane.
 CRITICAL STEP The milling and imaging cycle should be completed in 2 min. This comprises 90 s for the imaging and 30 s 
for the milling. Longer cycles should be avoided as the milling thickness becomes inconsistent.

? TROUBLESHOOTING
 PAUSE POINT The rest of the procedure is image analysis, thus the experiment can be paused indefinitely here.

3D reconstruction and analysis ● TIMING ~3 h
64| Combine individual sequential images acquired by FIBSEM (in tiff image format) into a single stack by using an  
appropriate software package, for example Fiji (http://fiji.sc/wiki/index.php/Fiji). Combine images in Fiji by clicking  
on File → Import → Image Sequence command.

65| If the stack requires alignment, then align. Using Fiji, select the Plugins → Registration → StackReg command.  
Align from the middle of the stack by using the transformation option ‘translation only’.

66| Crop the aligned stack to the desired size. In Fiji, use the ‘Rectangular’ selection and Image → Crop command.

67| Invert the image contrast to easily interpret the FIBSEM-acquired images. In Fiji, use Edit → Invert command  
(alternatively, Image → Lookup Tables → Invert LUT command). Adjust the image contrast by using the Image → Adjust → 
Brightness/Contrast command. Select either the ‘Auto’ option or adjust contrast manually, and select Apply.

68| Save final processed stack as sequence of individual 8-bit, grayscale images. This is performed in Fiji by using  
the File → Save As → Image Sequence command.

69| Measure the section thickness by using the mitochondria and the cylindrical diameters method13. Briefly, the section 
thickness is calculated by dividing the number of images across which a longitudinally milled mitochondrion is seen by its 
maximum diameter. This is repeated through the entire stack on >40 mitochondria.

70| Locate the position of the neurites of interest within the image stack by overlaying their two-photon image, which also 
includes the NIRB marks (Steps 22–25), with the image of the same marks in the imaged block (Step 51). This step is carried 
out by using imaging software such as Photoshop, ImageJ or GIMP.

71| Segment the structure of interest and create a 3D model by using appropriate software. This is described here using an  
automated approach of seeded watershed segmentation using the ilastik software (version 0.5.12; http://ilastik.org/). This 
could also be achieved by manually segmenting the features on each image of the stack by using software such as TrakEM2 
(ref. 14) in the FIJI program, although it would take considerably longer. On the splash screen of ilastik, choose ‘OpenGL’ for 
fastest 3D rendering or ‘Software’ in case OpenGL is not configured on the computer. Under the ‘Project’ tab, select ‘New’ button  
to load images. In the Project window, select ‘Load Stack’ and locate the folder where sequential images are stored. The entire 
stack is displayed in orthogonal views, giving the user the freedom to scroll through the stack in the x-y, x-z and y-z planes.

72| In the ‘Classification’ tab, select the ‘Select Features’ button to specify a set of features to be calculated to identify the 
membrane boundaries. In the ‘Spatial Features’ window, select ‘Texture’, which includes the Eigenvalues of the Hessian matrix 
as a membrane boundary indicator. Set the scale of the features to ‘Medium’ (representing sigma value of 1.0). The ilastik 
program will compute the selected set of features for the entire image stack.

73| Select ‘Seeded Watershed’ tab and import the previously calculated Eigenvalues of the Hessian matrix of Gaussian Sigma 
Channel 2 as chosen input weights. In the ‘Select Border Indicator’ window, specify whether the boundaries in ‘Calculated 
Weights’ are dark or bright. For Channel 2, select ‘Darkness’. Alternatively, if the selected Eigenvalue of Hessian matrix of 
Gaussian Sigma Channel is ‘0’, set the border indicator to ‘Brightness’. The ilastik program will then construct the supervoxel 
graph used for watershed segmentation.

74| Draw a line, or foreground seed, inside the structure of interest and in a different color mark the outside of the selected 
structure or background seed (Fig. 4a). As default, the background seed is in red and Seed 1 is in green. However, the user 
can create more seeds by using the button, or delete them by right-clicking on the list. The user can also change the color 
and width of these seeds.

75| Activate the ‘Segment’ button to start the segmentation process through the whole stack (Fig. 4b). The selected struc-
ture is colorized as ‘Segmentation’ overlay in the ‘Overlays’ preview window. Note that the seeds can be placed from any dis-
played planes of the orthogonal view. The segmentation can be iteratively assessed and refined by placing more foreground 
and background seeds, or by adding seeds for other objects. The ‘Bias’ dialog field allows the background seeds to grow more 
(values ~0.8) or less (values ~0.97) aggressively than the default.

http://fiji.sc/wiki/index.php/Fiji
http://ilastik.org/
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76| Render a 3D model of the segmented structure by right-clicking on the ‘Segmentation’ overlay and selecting ‘Display in 
3D’ (Fig. 4c).

77| Export the final model as a wavefront OBJ mesh file by selecting the export button to render high-quality images or 
movies by using the Blender 3D modeling software (version 2.69; Blender Foundation; http://www.blender.org/) (Fig. 4e).

? TROUBLESHOOTING
Troubleshooting advice can be found in Table 1.

Table 1 | Troubleshooting table.

Step Problem Possible reason Solution

6 Brain is soft, or blood is not  
completely flushed from the vessels

Poor perfusion Increase the amount PBS backfilled in the  
perfusion tubing 
Perfusion needle is not tightly clamped into heart

27 Dense precipitates seen in the EM 
images (‘black pepper effect’)

PBS is not properly rinsed out of 
the tissue

Increase number of washes with sodium 
cacodylate buffer to completely remove any 
traces of phosphate ions

28, 29, 
31

NIRB marks are not visible in the 
section after resin embedding

Tissue is too heavily stained owing 
to excessive staining with reduced 
osmium tetroxide 
Tissue is too heavily stained with 
uranyl acetate

Carefully monitor color of the section and reduce 
incubation time

Sections are thicker than 60 µm Ensure that brain is held firmly while it is  
sectioned in vibratome

Insufficient laser power results in 
marks that are too thin

Increase the laser power or number of line scans

37 Region of resin-embedded section, 
containing NIRB marks is not lying 
horizontally in the block

Section is too thin and curled  
during dehydration, and embedding 
NIRB marks lie at the very edge of 
the section

Check that section thickness is 60 µm when cut 
in the vibratome 
Ensure that regions of interest do not lie close to 
the section edges

39 Unable to find the laser marks in  
section after resin embedding

NIRB marks are too thin to be 
clearly visible with low-power 
objectives 
Not enough low-power images 
taken of section immediately after 
making NIRB marks

Increase laser power and number of line scans to 
increase the width of NIRB marks 
Image the section with transmitted light  
microscope at low and high power to capture 
NIRB marks and surrounding features, such as 
blood vessels and cell bodies

40 Laser-etched marks made with laser 
dissecting microscope are too large

Setting parameters for pulsed laser 
are too high

Reduce the power of pulsed laser. Take care to 
observe how the laser etches the surface more 
deeply when tissue is at the block surface.

47, 48 It is difficult to trim smooth  
surfaces while making the block

Glass knives are not sharp 
Block is not held firmly enough  
Knife is advancing too much each 
time

Use only freshly made glass knives  
Ensure that block is clamped firmly in the jaws of 
the holder  
Trim only 0.5 µm thickness each time

53 It is difficult to attain well-focused 
backscattered images in FIBSEM

Conductive gold layer on the block 
surface is too thin

Apply additional gold coat on the block  
face surface

60 Consecutive images are not from the 
same position on the block face

The block is drifting in relation to 
the electron beam

Ensure that microscope room temperature is not 
fluctuating  
Only visit the microscope briefly to check the 
image quality

63 Serial images do not show consistent 
Z spacing

No thermal steady-state has been 
reached, and block is expanding 
and contracting during the milling 
and imaging process

Imaging and milling should occur within ~2 min 
for each cycle

http://www.blender.org/
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● TIMING
Steps 1–14, fixation and vibratome sectioning: 3–4 h
Steps 15–17, location of the neurites of interest in the fixed sections: 30 min
Steps 18–25, generation of laser fiducial marks around the region containing the axons and dendrites of interest: 30 min
Steps 26–38, staining for EM and resin-embedding: 7–9 h (excluding resin polymerization)
Steps 39–50, preparation and trimming of the block face: ~2–5 h
Steps 51–53, mounting the block to SEM stub and gold coating: ~1.5 h
Steps 54–63, FIBSEM imaging face preparation and image acquisition: ~2 h and 48–72 h
Steps 64–77, 3D reconstruction and analysis: ~3 h

ANTICIPATED RESULTS
Successful NIRB marking of sections is dependent on the experimenter being able to see the marks during all parts 
of the subsequent block preparation. As the burning effect of the laser decreases deeper in the tissue, it is impor-
tant to check that the marks are clearly visible before embedding the sample in resin. This should be carried out by 
initially imaging with a two-photon microscope to ensure that all information is collected about the marks’ location 
with respect to the neurites of interest. However, it should also be performed with a transmitted light microscope at  
medium magnification (×20). If the marks are still clearly visible, then they will be seen after the staining and resin-
embedding steps.

NIRB marks are more easily made closer to the upper surface of the section; therefore, in this case, it may be better to 
turn a section over to have the NIRB marks closer to the upper face. This would mean that the block is then mounted  
upside-down on the resin slab. Therefore, the trimming and imaging need to account for the flipped orientation of neurites.

As the embedded section is densely stained, the NIRB marks may require intense illumination to be seen clearly during the 
block trimming. However, if they are located deep in the section, it is helpful to trim the excess material from above the  
region of interest to improve the illumination. The section in the resin can be imaged with a high-power objective (×100) 
with immersion oil in contact with its surface to produce the best images. The polymerized resin can be cleaned afterward 
with ethanol before it sticks to the resin slab. As the FIBSEM targets only the region of the NIRB marks, as the neurites are 
no longer fluorescent or specifically stained, it is important to gather as much information about this region before putting 
it in the electron microscope. It is also important to note that, although there is a certain degree of tissue shrinkage that 
occurs during the initial fixation, no discernible distortion occurs in the staining and embedding phase. Therefore,  
the orientation of the features seen in the resin clearly matches that seen in the two-photon images of the fixed section,  
i.e., distances between the features remain the same. However, when the sections are embedded they may not lie flat after 
polymerization, and slight undulations may appear. These can tilt the region of interest so that it does not lie parallel with 
the resin surface. This can be corrected in the trimming process by tilting the block so that a newly cut face is trimmed 
parallel to the NIRB marks.

The trimming phase of the protocol is the most crucial for ensuring that the least amount of time is spent using the FIB 
to expose the region of interest. The use of new glass knives is crucial for accurate trimming, as are the regular checks made 
with the light microscope to measure the distances between the NIRB marks and the edge of the block.

This protocol has been used in a number of studies in which dendrites and axons were imaged in vivo15,16. These have 
included not only GFP-expressing neurites of excitatory neurons but also tdTomato-labeled inhibitory neurons7.

Most of the previous studies, which used immunocytochemistry to carry out this type of correlative microscopy, have 
focused on dendrites. Targeting axons with the labeling method proved difficult owing to problems with adequate staining 
of these structures that are often thin and not easily distinguished among the rest of the neuropil. This problem is removed 
in the current protocol as the neurites of interest are not labeled specifically, only the region in which they were seen is 
targeted, therefore optimal fixation and staining conditions can be used. The EM staining part of the protocol uses a  
conventional approach–staining recipe at ambient temperature; however, other protocols that maximize the preservation of 
the membranes while also allowing heavy contrasting of the membrane could also be envisaged17. Although this method only 
describes how this procedure can be carried out on dendrites and axons from live-animal experiments, it is equally applicable 
to acute or cultured slice preparations.

Concluding remarks
Block-face scanning EM techniques allow for automated collection of aligned serial images through substantial volumes of 
resin-embedded cells and tissues. Compared with the serial TEM approach, this is a fast and more reliable method and also 
allows EM images to be collected through volumes in which structures of interest, previously seen with light microscopy,  
are located. Therefore, if the required structures are recognizable in the EM images, or their exact position is pinpointed  
from the light microscope images, there is no need to use labels that can be seen in both imaging modes. This approach, 
without specific EM labels, means that any fluorophore seen in fixed material is compatible. This opens up many opportunities  
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to carry out correlative EM analysis on the vast array of different fluorophores to combine temporal information on many 
scales with high-resolution data in 3D.

Acknowledgments This work was supported by the Swiss National Foundation 
Synergia project grant CRF II313470/1 (G.W.K.) and project grant 31003A_
135631 (A.H.).

AUTHOR CONTRIBUTIONS G.W.K. and A.H. conceived and designed experiments. 
A.H., G.W.K. and B.M. performed in vivo imaging, vibratome sectioning and laser 
mark branding. G.W.K., M.C. and B.M. performed electron microscopy and FIBSEM 
imaging. A.H., G.W.K., B.M., A.K. and F.A.H. analyzed the data and materials, and 
contributed reagents and analysis tools. G.W.K., B.M., A.H., M.C. and F.A.H. wrote 
the manuscript.

COMPETING FINANCIAL INTERESTS The authors declare no competing financial 
interests.

Reprints and permissions information is available online at http://www.nature.
com/reprints/index.html.

1.	 Holtmaat, A. et al. Long-term, high-resolution imaging in the mouse 
neocortex through a chronic cranial window. Nat. Protoc. 4, 1128–1144 
(2009).

2.	 Trachtenberg, J.T. et al. Long-term in vivo imaging of experience-dependent 
synaptic plasticity in adult cortex. Nature 420, 788–794 (2002).

3.	 Knott, G.W., Holtmaat, A., Wilbrecht, L., Welker, E. & Svoboda, K.  
Spine growth precedes synapse formation in the adult neocortex in vivo. 
Nat. Neurosci. 9, 1117–1124 (2006).

4.	 Shu, X. et al. A genetically encoded tag for correlated light and electron 
microscopy of intact cells, tissues, and organisms. PLoS Biol. 9, e1001041 
(2011).

5.	 Knott, G.W., Holtmaat, A., Trachtenberg, J.T., Svoboda, K. & Welker, E.  
A protocol for preparing GFP-labeled neurons previously imaged in vivo  
and in slice preparations for light and electron microscopic analysis.  
Nat. Protoc. 4, 1145–1156 (2009).

6.	 Knott, G., Marchman, H., Wall, D. & Lich, B. Serial section scanning 
electron microscopy of adult brain tissue using focused ion beam milling. 
J. Neurosci. 28, 2959–2964 (2008).

7.	 Maco, B. et al. Correlative in vivo 2 photon and focused ion beam 
scanning electron microscopy of cortical neurons. PLoS ONE 8, e57405 
(2013).

8.	 Bishop, D. et al. Near-infrared branding efficiently correlates light and 
electron microscopy. Nat. Methods 8, 568–570 (2011).

9.	 Kreshuk, A. et al. Automated detection and segmentation of synaptic 
contacts in nearly isotropic serial electron microscopy images. PLoS ONE 
6, e24899 (2011).

10.	 Straehle, C.N., Köthe, U., Knott, G. & Hamprecht, F.A. Carving: scalable 
interactive segmentation of neural volume electron microscopy images. 
Med. Image Comput. Comput. Assist. Interv. 14, 653–660 (2011).

11.	 Denk, W. & Horstmann, H. Serial block-face scanning electron microscopy 
to reconstruct three-dimensional tissue nanostructure. PLoS Biol. 2, e329 
(2004).

12.	 Helmstaedter, M. et al. Connectomic reconstruction of the inner plexiform 
layer in the mouse retina. Nature 500, 168–174 (2013).

13.	 Fiala, J.C. & Harris, K.M. Cylindrical diameters method for calibrating 
section thickness in serial electron microscopy. J. Microsc. 202, 468–472 
(2001).

14.	 Cardona, A. et al. TrakEM2 software for neural circuit reconstruction.  
PLoS ONE 7, e38011 (2012).

15.	 Mostany, R. et al. Altered synaptic dynamics during normal brain aging.  
J. Neurosci. 33, 4094–4104 (2013).

16.	 Grillo, F.W. et al. Increased axonal bouton dynamics in the aging mouse 
cortex. Proc. Natl. Acad. Sci. USA 110, E1514–1523 (2013).

17.	 Sosinsky, G.E. et al. The combination of chemical fixation procedures with 
high pressure freezing and freeze substitution preserves highly labile 
tissue ultrastructure for electron tomography applications. J. Struct. Biol. 
161, 359–371 (2008).

http://www.nature.com/reprints/index.html
http://www.nature.com/reprints/index.html



